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1 Overview
Introduction

BroadR-Reach specifications (see “Reference Documents” on page 47) defines 
the use of various test modes for testing compliance with the BroadR-Reach 
Physical Layer (PHY) transmitter. BroadR-Reach was developed by Broadcom 
Corporation specifically for automotive applications. OPEN (One Pair EtherNet) 
Alliance standardized the technology and established the standard. 100 Mbit/s 
Ethernet for automotive applications was standardized as IEEE 802.3bw with the 
terminology 100 Base-T1.

Keysight’s N6467B 100BaseT1-TX Compliance Application Software (provided as 
a software option to the E6961A Automotive Ethernet Solution) provides five test 
modes for the testing and validating the transmitter waveform, transmitter 
distortion, transmitted jitter, and transmitter droop. The test modes change only 
the data symbols provided to the transmitter circuitry and do not alter the 
electrical and jitter characteristics of the transmitter and receiver from those of 
normal operation. 

Table 1-1 List of Test Modes available

Test Mode Description

1 Transmit droop (positive and negative) test mode

2 Transmit jitter test in MASTER mode

3 Transmit jitter test in SLAVE mode

4 Transmitter distortion test

5 Power Spectral Density (PSD) mask and test.

NOTE
This E6961A User Guide is written as a guide to using the N6467B BroadR-Reach 
TX Compliance Application software. For information on the N8847A 
BroadR-Reach Protocol Triggering and Decoder software, the E6960A 
1000BaseT1 TX Compliance Application, or the E6964A BroadR-Reach MDI 
S-Parameter software, refer to their respective documentation.
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Overview 1
Using the Keysight N6467B BroadR-Reach TX Compliance Application 
(100Base-T1 compliant) software along with an N5395C Ethernet Test Fixture 
greatly simplifies BroadR-Reach compliance testing. The software automatically 
configures all of the required test equipment reducing the overall test time.

The N6467B Software:

– Lets you select individual or multiple test to run.

– Lets you identify the device being tested and its configuration.

– Shows you how to make oscilloscope connections to the device under test.

– Automatically checks for proper oscilloscope configuration.

– Automatically sets up the oscilloscope for each test.

– Allows you to determine the number of trials for averaging in each test.

– Provides detailed information of each test that has been run. The result of 
maximum 64 worst trials can be displayed at any one time.

– Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen captures.

Installing the Compliance Test Solution Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the software release notes) by choosing Help > About Infiniium... from the 
main menu.

2 To obtain the N6467B BroadR-Reach Compliance Test Application, go to 
Keysight website: http://www.keysight.com/find/N6467B.

3 Click the Trials & Licenses tab.

4 Click the Details & Download button.

5 Read and verify the Prerequisites and installation information. Follow the 
instructions to download and install the application software. Click the red 
Download button.
Keysight E6961A User Guide and Method of Implementation 11
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1 Overview
Installing the License Key

1 Request a license code from Keysight by following the instructions on the 
Entitlement Certificate. You will need the oscilloscope's “Option ID Number”, 
which you can find in the Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Utilities > License 
Manager > Legacy Licenses.... Depending on the license acquired, select 
either Local License or Server License.

3 In the Install Option License dialog box, enter your license code and click 
Install License. Additional information is required for server based licensing. 
Please refer to your entitlement.

4 Click OK in the dialog box that tells you to restart the Infiniium oscilloscope 
application software to complete the license installation.

5 Click Close to close the Install Option License dialog box.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license 
installation.

8 You can also install the license using Keysight License Manager. 

For detailed instructions, refer to the online help for the Keysight License 
Manager.
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Overview 1
Preparing to Take Measurements

Before running the E6961 automated compliance tests, you should calibrate the 
oscilloscope and probe. After calibrating the oscilloscope and probe, you are 
ready to start the Compliance Test Application and perform the measurements.

Calibrate the Oscilloscope

For information on performing the internal diagnostic and calibration cycle for 
your Keysight Infiniium oscilloscope, refer to the "User Calibration" topic in your 
oscilloscope's online help.

Probe Calibration

Before performing the automated tests, you should calibrate the probes. 
Calibration of the solder-in probe heads consists of a vertical calibration and a 
skew calibration. The vertical calibration should be performed before the skew 
calibration. Both calibrations should be performed for best probe measurement 
performance.

For information on performing probe vertical and skew calibration in your Keysight 
Infiniium oscilloscope, refer to the "DC Attenuation/Offset Calibration" and 
"Skew Calibration" topics in your oscilloscope's online help.

For more information on calibration/deskew procedures for your particular probe, 
refer to the probe's user's guide in the Keysight Probe Resource Center.

NOTE
If the ambient temperature changes more than 5 °C from the calibration 
temperature, internal calibration should be performed again. The delta between 
the calibration temperature and the present operating temperature is shown in 
the Utilities > Calibration menu.

NOTE
If you switch cables between channels or other oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
Keysight E6961A User Guide and Method of Implementation 13



1 Overview
General Test Setup

Test Modes 1, 2, 3, and 5 require only the Infiniium oscilloscope and the device to 
be tested (Device Under Test or DUT). The test setup is described below. 
Differential Signal supplied to the Oscilloscope can be achieved either by using 
Two Oscilloscope Channels or a Single Differential Probe. The type of 
connection accepted can be selected in the Setup tab of the test application.

Two Oscilloscope Channels refers to connecting the differential automotive pair to 
the oscilloscope using only SMA cables. Refer to Figure 1-1 for more details

Single Differential Probe refers to connecting the differential automotive pair to 
the Oscilloscope using a single differential probe. Refer to Figure 1-2 for more 
details. The only variation would be the Power Spectral Density Level test that 
requires a balun.

Any variation from the above definition of differential signalling type is not 
recommended

Test Mode 4 requires the N5395C Ethernet Test Fixture and an Arbitrary 
Waveform Generator (AWG). Refer to “Test Mode 4. Transmitter Distortion and 
MDI Return Loss Tests” on page 34 for specific setup details. 

Test Mode 4 also includes an MDI S-Parameter Test. This test is also available as 
E6964A BroadR-Reach MDI S-Parameter Software. The E6964A software does 
not require the Infiniium oscilloscope. 

Test Mode 5 can also use the N9010B Signal Analyzer. Refer to “Test Mode 5. 
Transmitter Power Spectral Density (PSD) and Transmitter Peak Differential 
Output Tests” on page 42 for specific setup details.

Two Oscilloscope Channels Connection to Oscilloscope

Two SMA cables are needed to directly connect the output of the transmitter to 
the oscilloscope. The specific oscilloscope channel used can be selected in the 
Configure tab of the application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.
14 Keysight E6961A User Guide and Method of Implementation



Overview 1
Figure 1-1 Connection to the Oscilloscope Using a Pair of SMA Cables

Single Differential Probe Connection to Oscilloscope

A differential probe is used to connect the output of the transmitter to the 
oscilloscope. The specific oscilloscope channel used can be selected in the 
Configure tab of the application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.

Figure 1-2 Connection to the Oscilloscope using a Differential Probe
Keysight E6961A User Guide and Method of Implementation 15



1 Overview
Connection Using the N5395C Ethernet Transmitter Test Fixture

Alternately, you can use Section 1 of the N5395C Ethernet 10/100/1G Transmitter 
Electrical Test Fixture to make connections to the Transmitter under test. The 
SMA connections shown are for wire pair A (DA+ and DA–) in the RJ45 cable. This 
connection is only valid if the DUT has an RJ45 connector. To test to wire pair B, 
C, or D, connect the oscilloscope SMA cables to the appropriate Evaluation Board 
SMA connectors. In the event the DUT does not have a RJ45 connector, user will 
need to replace Section 1 with any adapter that converts the differential 
automotive pair to SMA.

Figure 1-3 General Test Setup using the N5395C Evaluation Board
16 Keysight E6961A User Guide and Method of Implementation



Overview 1
NOTE
For all tests, use the software supplied with your transmitter PHY to control the 
Device Under Test.
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1 Overview
Starting the Automotive Ethernet Compliance Test Solution 
Software

1 Ensure that the BroadR-Reach/100Base-T1 Device Under Test (DUT) 
transmitter is operating and set to desired test modes.

2 To start the Compliance Test Application from the Infiniium oscilloscope's main 
menu, select Analyze > Automated Test Apps > N6467A/N6467B 
BroadR-Reach Test App. 

Figure 1-4 Launching the BroadR-Reach Compliance Test Application
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Overview 1
Figure 1-5 BroadR-Reach Compliance Test Application Main Window

The Compliance Application software automatically sets frequency, etc. of the 
external instruments (oscilloscope, ENA, generators, etc.) if they are properly 
configured. Refer to “Appendix D: Using the E6960-66600 Frequency Divider 
Board” on page 67.

The task flow pane, and the tabs in the main pane, show the steps you take in 
running the automated tests:

Requires Frequency Divider 
Board. See Appendix D: 
Using the E6960-66600 
Frequency Divider Board 

67.

Use 
TX_CLK. 
Check this if 
your DUT 
has its own 
Transmit 
Clock. 
Otherwise, 
the default 
clock signal 
is used. 

Refer to “Appendix C: External 
Instrument Calibration” on 
page 59.

Refer to “Appendix B: Configure 
External Instruments” on page 57.
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1 Overview
Figure 1-6 Select Tests Menu with all Tests Selected

Displays test limits, test 
description, and IEEE 
specification reference for 
the selected test.
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Overview 1
 

Table 1-2 List of tabs available

Tab Description

Set Up Lets you identify and set up the test environment.

Select Tests
Lets you select the tests you want to run. After tests are run, status indicators show which tests have 
passed, failed, or have not run.

Configure
Lets you configure test parameters (for example, oscilloscope channels used in test, number of 
averages, etc.).

Connect Shows you how to connect the oscilloscope to the device under test.

Run Tests
Starts the automated tests. If the connections to the device under test need to be changed, the test 
pauses, shows how change the connection, and waits for you to confirm that the changes were made 
before continuing.

Automation Lets you construct scripts of commands to drive execution of the application.

Results
Contains more detailed information about the tests that have been run. You can change the thresholds 
at which marginal or critical warnings appear.

HTML Report Report Shows a compliance test report that can be printed. See “Viewing the Test Report” on page 45
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1 Overview
Figure 1-7 Configure Tab for Test Mode 1

The Configure 
Tab allows 
you to select 
different 
oscilloscope 
channels and 
measurement 
attributes.

For example, 
the signal 
input can be 
changed from 
a differential 
probe to two 
SMA cables.
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Overview 1
Figure 1-8 Connect Tab for Test Mode 1

Test connections are clearly identified including additional hardware and 
cables. When you make multiple tests where the connections must be 
changed, the software prompts you with appropriate connection diagrams.

Check the, “I have completed these instructions” box before clicking the Run 
Tests button.
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1 Overview
Top Menu Bar

The top menu bar of the compliance application offers several features:

Figure 1-9 Navigation menus

Top Menu Bar icons from left to right:

Start a new project: Closes existing project and opens a new project.

Open an existing project: If you saved a previous project, this icon allows you 
to open it. You can load a sample project from: 
C:\Users\Public\Documents\Infiniium\Apps\BroadR-ReachTest\ProjectSampl
es\BroadRReach Device 1.proj.

Save the current project: Saves the current project in the following folder: 
C:\Users\Public\Documents\Infiniium\Apps\BroadR-ReachTest\BroadRReach 
Device 1.

Configure checked tests: Same as the Configure tab.

Run all checked tests: Runs all of the selected tests. Same as the Run Tests 
tab.

Run selected branch only: Runs only the selected test.

View results: Opens the HTML Report window. Same as the Html Report tab.

Tabs

The tabs across the top correspond to the Task Flow icons on the left side of the 
main display.

Top Menu Bar

Tabs
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Overview 1
Test Mode 1. Output Droop Tests

Test Setup

This test may be run using either a two oscilloscope channels or a single 
differential probe from the transmitter (MDI). Refer to “General Test Setup” on 
page 14 for connection details.

Specification References

[1] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.1.

Transmitter Output Droop Positive Test Information

This test measures the positive output droop of the transmitter.

Reference [1] specifies the positive output droop of a compliant PHY. The positive 
droop measured with respect to the initial peak value after the zero crossing and 
the value 500 ns after the initial peak, shall be less than 45%.

The application triggers the Test Mode 1 signal on the rising edge and determines 
the time the positive peak occurred and the voltage at that specific instance. The 
application then measures the voltage 500 ns after the peak. The Droop is 
calculated as:

Droop = 100 X (Vd/Vpk)%

Where:

– Vd is the magnitude of the droop.

– Vpk is the initial peak after the zero crossing.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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1 Overview
Typical Waveform

Figure 1-10 Typical Positive Droop Test Waveform (using a pair of SMA 
cables)

Transmitter Output Droop Negative Test Information

This test measures the negative output droop of the transmitter.

Reference [1] specifies the negative output droop of a compliant PHY. The 
negative droop measured with respect to the initial peak value after the zero 
crossing and the value 500 ns after the initial peak, shall be less than 45%.

The application triggers the Test Mode 1 signal on the falling edge and 
determines the time the negative peak occurred and the voltage at that specific 
instance. The application then measures the voltage 500 ns after the peak. The 
Droop is calculated as:

Droop = 100 X (Vd/Vpk) %

Where:

– Vd is the magnitude of the droop.

– Vpk is the initial peak after the zero crossing.
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Overview 1
Typical Waveform

Figure 1-11 Typical Negative Droop Test Waveform (using a pair of SMA 
cables)
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1 Overview
Test Mode 2. MASTER Clock Frequency and Jitter Tests

Test Setup

This test may be run using either a differential output or single-ended output from 
the transmitter (MDI). Refer to “General Test Setup” on page 14 for connection 
details.

Specification References

[1] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.5.

[2] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.2.

[3]  BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.3.

Transmit Clock Frequency (MASTER) Test Information

This test measures the frequency of the transmitter clock when the PHY is 
operating in MASTER mode.

Reference [1] specifies the symbol transmission rate of a compliant PHY. The 
symbol transmission rate of the MASTER PHY shall be within the range if 66 2/3 
MHz ±100 ppm.

The Reference [2] specifies that Test Mode 2 shall transmit the data symbol 
sequence {+1,-1} repeatedly on the channel. The transmitter shall time the 
transmitted symbols from a symbol rate clock in the MASTER timing mode. The 
measured data rate of the Test Mode 2 signal is thus equal to the MASTER 
Transmit Clock Frequency of the PHY.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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Overview 1
Typical Waveform

Figure 1-12 Typical MASTER Clock Test Waveform (using a pair of SMA 
cables)
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1 Overview
MASTER TxOut Jitter Test Information

Reference [3] specifies that when in test mode 2, the RMS (Root Mean Square) 
value of the MDI output jitter, JTXOUT, relative to an unjittered reference shall be 
less than 50 ps.

This test measures the data time interval error of the test mode 2 signal at the 
MDI. The ideal reference data rate is selected automatically by the oscilloscope 
and compared to the original signal to determine the data time interval error.

Typical Waveform

Figure 1-13 Typical MASTER TX Out Test Waveform (using a pair of SMA 
cables)
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Overview 1
Test Mode 3. SLAVE Transmit Clock Frequency and Jitter Tests

Test Setup

This test may be run using either a differential output or single-ended output from 
the transmitter (MDI). Alternatively, this test can also be run using the TX_TCLK. 
Refer to “General Test Setup” on page 14 for connection details.

Specification References

[1] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.5.

[2] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.2.

[3] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.3.

Transmit Clock Frequency (SLAVE) Test Information

Reference [1] specifies the symbol transmission rate of a compliant PHY. The 
symbol transmission rate of the MASTER PHY shall be within the range if 66 2/3 
MHz ±100 ppm.

The specification does not specify the conformance limit for a PHY that is 
operating in SLAVE mode, but the SLAVE is supposed to have a symbol clock rate 
that is equal to the MASTER PHY. 

Reference [2] specifies that Test Mode 3 shall transmit the data symbol sequence 
{+1,-1} repeatedly on the channel. The transmitter shall time the transmitted 
symbols from a symbol rate clock in the SLAVE timing mode.

Alternatively, an external TX_TCLK could be used to measure the frequency.

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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1 Overview
Typical Waveform

Figure 1-14 Typical TX Test Waveform (using a pair of SMA cables)
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Overview 1
Slave TX_TCLK Jitter Test Information

Reference [3] specifies that the RMS value of the SLAVE TX_TCLK jitter 
relative to an unjittered reference shall be less than 0.01 UI (Unit Interval) 
after the receiver is properly receiving the data. This test measures the 
data time interval error at the MDI. The ideal reference data rate is 
selected automatically by the oscilloscope and compared to the original 
signal to determine the data time interval error.

Alternatively, an external TX_TCLK could be used to measure the jitter.

Typical Waveform

Figure 1-15 Typical TX-TCLK Test Waveform (using a pair of SMA cables)
Keysight E6961A User Guide and Method of Implementation 33



1 Overview
Test Mode 4. Transmitter Distortion and MDI Return Loss Tests

Test Setup

Sections 1 and 11 of the N5395C Ethernet Test Fixture are used in this test.

A disturbing signal source is required to test for compliance. There is an option to 
test without a disturbing signal source, but the test result is not applicable for 
compliance. The test accepts only a differential signal.

When using a supported function generator, there is an automatic calibration 
process to calibrate the function generators. If an unsupported model is used, the 
user will have to manually calibrate the function generators.

Table 1-3 List of supported function generators

Supported Function Generators Number Required Notes

Keysight 33250A 2
Keysight 82357B USB/GPIB interface and one additional GPIB 
cable required.

Keysight 33612A 1 LAN Cable required.

Keysight 81150A 1
LAN Cable required. (2- Channel, orderable through E6961A 
Compliance Test Solution
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Overview 1
Figure 1-16 Transmitter Distortion Test Connection Using two Keysight 
33250A Function Generators
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1 Overview
Figure 1-17 Connection for Transmitter Distortion Test Using Keysight 
33612A Function Generator
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Overview 1
Figure 1-18 Connection for Transmitter Distortion Test Using Keysight 
81150A Function Generator

Using the Optional E6961A Frequency Divider Board

If you want to use the optional E6961A Frequency Divider Board to provide a 
stable 10 MHz reference clock, refer to “Appendix D: Using the E6960-66600 
Frequency Divider Board” on page 67 for detailed information.

Specification References

[1] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.2.

[2] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 8.2.2.
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1 Overview
Transmitter Distortion Tests Information

When operating in Test Mode 4 and capturing the waveform using the Section 11 
of the fixture, the peak distortion shall be less than 15 mV.

Reference [1] specifies that the peak distortion is determined by sampling the 
differential signal output with the symbol rate clock at an arbitrary phase and 
processing a block of any 2047 consecutive samples with MATLAB code in 
reference [1].

A software high pass filter is applied to the sampled signal before 
post-processing.

Alternatively, this test can also be run without the disturbing signal, but the result 
cannot be used to determine compliance.

Transmitter Distortion Enhance Clock Recovery Algorithm

Keysight employs an enhanced clock recovery algorithm when the TX_TCLK is not 
available. The algorithm conditions the signal to the nominal bitrate. This is 
enabled by default when the Use 10MHz Ref Clock checkbox is disabled.

When the Use 10MHz Ref Clock checkbox is enabled, the E6960-66600 
Frequency Divider board as well as access to TX_TCLK is required for 
synchronization.

NOTE
If using the Frequency Divider, connect the 10 MHz output(s) of the divider to 
the 10 MHz Ref In Input of the oscilloscope and function generator for clock 
synchronization.

NOTE
This test can only be run using a differential output from the transmitter (MDI). 
Refer to “General Test Setup” on page 14 for connection details. A differential 
probe cannot be used for this test.
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Typical Waveform

Figure 1-19 Typical Distortion Test Waveform (using a pair of SMA cables)
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1 Overview
MDI Return Loss Test

Run the Management Data Input (MDI) Return Loss test with a vector network 
analyzer connected externally to the oscilloscope.

Test Setup

Figure 1-20 Connection Setup for MDI Return Loss test
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Overview 1
MDI Return Loss Test Information

This test can run with an external vector network analyzer. However, an ENA 
exported data file in the Touchstone or CITI format can also be used in place of 
the external vector network analyzer.

Reference [2] specifies that the MDI return loss shall meet or exceed the following 
equation for all frequencies ranging from 1 MHz to 66 MHz (with 100 Ω reference 
impedance) at all times when the PHY is transmitting data or control symbols.

NOTE
Calibrate the ENA prior to running the tests. Set the ENA as follows:

     Measurement: Ref1 Fwd S11

     Start Frequency: 1 MHz

     Stop Frequency: 66 MHz

     Turn Averaging On

Table 1-4 Frequency and Return Loss

Frequency Return Loss (dB)

1 - 30 MHz 20

30 - 66 MHz 20 - 20*log(f/30)
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1 Overview
Test Mode 5. Transmitter Power Spectral Density (PSD) and 
Transmitter Peak Differential Output Tests

Test Setup

The Power Spectral Density (PSD) Test can be run using either a spectrum 
analyzer or an oscilloscope. When using the Oscilloscope, refer to “General Test 
Setup” on page 14 for testing using oscilloscope.

If you use the N9010B Signal Analyzer, convert the differential output to a 
single-ended output using a balun. Use the balun on the N5395C Ethernet Test 
Fixture as shown in Figure 1-19 on page 39.

Figure 1-21 Power Spectral Density Test Using N9010B Signal Analyzer

NOTE
Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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Specification References

[1] BroadR-Reach Physical Layer Transceiver Specification, v3.2, Section 5.4.4.

[2] 100Base-T1, IEEE Std. 802.3bw-2015, Section 96.5.6.

PSD Test Information

Reference [1] specifies that in Test Mode 5, the power spectral density (PSD) of 
the transmitter, shall be between the upper and lower bounds specified in the 
table below.

The upper and lower limits are piece-wise linear masks connecting points given in 
the table above. A lower PSD mask is provided to ensure the tolerances.

This test could be run using an external spectrum analyzer or the oscilloscope.

Table 1-5 PSD Test settings

Frequency PSD Upper Bound (dBm) [a] PSD Lower Bound (dBm) 1

@1 MHz -23.3 -30.7

@20 MHz -24.8 -35.6

@40 MHz -28.5 -49.0

57 MHz-200 MHz -36.5 –

[a] Settings: RBW=10 kHz, VBW=30 kHz, sweep time >1 min, RMS detector, sweep time 3.275 
seconds.
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1 Overview
Typical Waveform

Figure 1-22 Typical Spectral Density Loss Test Waveform

Transmitter Peak Differential Output

Reference [2] specifies that in Test Mode 5, when measured with 100 Ω 
termination, the transmit differential signal at MDI shall be less than 2.2 Volt 
peak-to-peak.
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Viewing the Test Report

After running any or all of the five Compliance tests, the Results tab shows which 
tests passed and details about the individual tests. For test result details, select 
any one of the tests form the top pane; the test details are shown below. In 
Figure 1-23 below, the Transmitter Power Spectral Density test is selected and 
the test results, with waveform, is shown below. 

Figure 1-23 Typical Results Tab

Figure 1-24 below shows a portion of a typical HTML Report. Below this segment 
are waveforms and more test data.
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1 Overview
Figure 1-24 Top Portion of a Typical HTML Report
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Reference Documents

OPEN Alliance / BroadR-Reach Specifications: 
www.opensig.org or www.ieee802.org

Keysight’s Automotive Ethernet Test Solutions Web Page: 
www.keysight.com/find/BroadR-Reach

E6961A Automotive Ethernet TX Compliance Solution Web Page:
www.keysight.com/find/E6961A

Other Keysight Automotive Ethernet Applications and Software

– E6960A 1000Base-T1 TX Compliance Application: www.keysight.com/find/
E6960A

– E6961A Automotive Ethernet TX Compliance Solution: www.keysight.com/
find/E6961A

– E6962A Automotive Ethernet RX Compliance Solution –
includes E6962A BroadR-Reach RX Compliance Application (100Base-T1 
compliant) software :
www.keysight.com/find/E6962A

– E6963A BroadR-Reach Automotive Ethernet Link Segment Compliance 
Solution – includes E6963A BroadR-Reach Link Segment Compliance 
Application (100Base-T1 compliant) software:
www.keysight.com/find/E6963A

– N6467B BroadR-Reach Transmit Compliance Application Software 
(100Base-T1 compliant):
www.keysight.com/find/N6467B

– N8847A Protocol Triggering and Decoder Software (100Base-T1 compliant)
www.keysight.com/find/N8847A
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
Introduction

Keysight’s N5395C Ethernet 10/100/1G Transmitter Electrical Test Fixture 
includes a main test fixture board (N5392-66402), a short RJ-45 interconnect 
cable (N5392-61601), and a small Return Loss impedance calibration board 
(N5392-66401).

Keysight’s N5395C Ethernet Test Fixture is recommended for the Compliance Test 
Mode 4. A different, comparable fixture may be used, but is not guaranteed to 
produce the same result.

Notice that the main Test Fixture board is divided into eight sections plus an area 
to store jumpers. Not all sections are used in this demo/evaluation. Refer to 
Figure A-2 on page 51.

The Return Loss impedance calibration board is Board Section 8. See Figure A-1 
below. This board is used for calibrating the ENA. Refer to “Calibrating the ENA” 
on page 62. This board is only applicable if your DUT has a RJ45 connector. For 
other DUT's that do not have a RJ45 connector, user will need to fabricate a 
custom calibration kit.

Table A-1 List of Compliance Test Board Sections

Compliance Test Board 
Section

Description Compliance Test Mode Number

1 Differential Return Loss used for RJ45 devices Test Mode 4, Transmitter Distortion Test

2 Load & Probes Not Used

3 100BT Jitter Not Used

4 Common Mode Output Voltage Not Used

6 10BT w/o TP Model Not Used

7 10BT with TP Model Not Used

10 Balun used for Power Spectrum Density Test Test Mode 4, MDI Return Loss Test

11 Disturbance/Distortion Test Mode 4, Transmitter Distortion Test
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Setting Up the N5395C Ethernet Transmitter Test Fixture A
Figure A-1 Return Loss Impedance Calibration Board

Figure A-2 N5395C Ethernet Electrical Transmitter Test Fixture
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
Jumper Settings

Figure A-3 and Table A-2 on page 53 show the jumper positions for the Ethernet 
Test Fixture Section 11 applicable for various frequencies.

Figure A-3 Section 11 on the Ethernet Test Fixture. See Table 2 for Jumper 
Settings

Section 11 
Jumpers. See 
Table A-2 (next 
page) for 
settings.
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Setting Up the N5395C Ethernet Transmitter Test Fixture A
Table A-2 Jumper Locations for Ethernet Test Fixture (Section 11 on Test 
Fixture)

Filter Bandwidth Jumper Location

25 MHz

35 MHz

102 MHz
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A Setting Up the N5395C Ethernet Transmitter Test Fixture
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B Configure External Instruments
Introduction

For each test, the DSOS254A Infiniium Oscilloscope automatically configures any 
external instruments (AWG, E5071C ENA, and E9010B EXA Signal Analyzer) as 
required for the test. In order to do this, however, the oscilloscope must know the 
SICL address of each instrument. The External Instruments Status indicator is red 
if the instruments are not properly configured.

1 From the BroadR-Reach Compliance Test Application Set Up tab, click the 
Configure button.

Figure B-1 BroadR-Reach Compliance Test Application Main Menu

NOTE
The instruments must be connected to the oscilloscope prior to configuring 
them. This is generally through a USB connection.

Note that the 33250A AWGs require an 82357B USB/GPIB interface. You must 
configure the Master and Slave 33250A AWGs separately.
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Configure External Instruments B
2 This opens the External Instruments List dialog box. 

Figure B-2 BroadR-Reach Compliance Test Application External 
Instruments List

3 Select the AWG used in your system. For the E6961A Solution, this would be 
the Fg81150/60.

4 If you know the SICL address (you can use Keysight IO Libraries Suite 
Connection Expert utility to obtain the SICL address) enter it in the SICL 
Address field. If you do not know the SICL address, click the Find button and 
the Test Compliance Software will attempt to locate and identify the AWG.

5 Click the Update button.

6 Repeat steps 3, 4, and 5 for the E5071C ENA and the N9010B EXA Spectrum 
(or Signal) Analyzer. 

7 When you are finished, click the Done button to return to the Main Menu.

8 The External Instruments Status indicator turns green to indicate that all 
external instruments have been properly configured.
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C External Instrument Calibration
Introduction 

All instruments must be calibrated prior to running the Compliance tests. The 
compliance application software guides you in calibrating the AWG and the ENA.

Calibrating the AWG

Before running disturbing signal tests, the AWG(s) must be calibrated. Connect 
the equipment as shown in Figure C-1 on page 61.

NOTE
The AWG Disturbing Signal Source must be Configured before attempting to 
Calibrate it. If the system is not physically configured to perform the calibration, 
the application prompts you to change the physical configuration. Refer to 
“Appendix B: Configure External Instruments” on page 57

NOTE
Instead of connecting SMA to SMA cables on the N5393C Evaluation Board, 
connect 50 Ω Terminators to the two DUT SMA Connectors on the Evaluation 
Board. This is shown in Figure C-1 below
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External Instrument Calibration C
Figure C-1 AWG Calibration Setup for the Disturbing Signal Source

Performing the AWG Calibration for the Disturbing Signal Source

1 From the BroadR-Reach Compliance Test Application software main menu, 
click the Calibrate Sources button.

Connect BNC to BNC 
cables to AWG Connect 50Ω SMA 

Terminations

BNC to SMA Cables

N5395A Ethernet Transmitter Test Fixture
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C External Instrument Calibration
Figure C-2 BroadR-Reach Compliance Test Application Main Menu

2 This opens the Calibrate Disturbing Signal dialog box for the selected AWG. 

3 With the appropriate AWG Address set and the correct oscilloscope channels 
selected, click the Calibrate button to start the calibration process.

4 When the software finishes the calibration, click the Done button to return to 
the Main Menu. Refer to the E6961A online help for a more detailed 
explanation.

Calibrating the ENA

Before using the ENA, it must be calibrated using the Return Loss Calibration 
board. See Figure C-3 below for the connection diagram. Calibrate the ENA using 
the instructions in the ENA’s User’s Guide.
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External Instrument Calibration C
Figure C-3 ENA Calibration Setup

1 Connect the Return Loss Calibration board RJ45 connector labeled OPEN to 
the RJ45 connector on the main test fixture board using a short 
straight-through UTP cable.

Short 
SMA 
Cables

Short RJ45 cable

Return Loss Impedance 
Calibration Board

Load Short Open

N5395C Ethernet Transmitter Test Fixture
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C External Instrument Calibration
2 Connect one end of two short SMA-to-SMA cables to the SMA test points for 
the pair you are testing (A, B, C, or D) on Section 1 of the test fixture. Connect 
the other end to the two SMA test points on Section 10 on the test fixture.

3 Connect a ENA input to the SMA test point on Section 10 on the test fixture.

4 Calibrate the ENA using the instructions in the ENA’s User’s Guide. The 
following is a list of setup requirements.

– Set Meas to Ref1 Fwd S11.

– Set Start to 1 MHz.

– Set Stop to 100 MHz.

– Set Format to Log Mag.

– Set Scale Div to 5.

– Set Scale Ref to reference line position 9.

5 5 Run the calibration for the OPEN, SHORT, and LOAD connections. For 
connectors other than RJ45, a custom calibration kit will need to be 
developed.
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D Using the E6960-66600 Frequency Divider Board
Introduction

Keysight’s E6960-66600 Frequency Divider Board produces two identical clock 
signal outputs (10 MHz) that are phase locked to the input clock. This Frequency 
Divider Board is recommended for Compliance Test Mode 4, Transmitter 
Distortion Test.

Figure D-1 Keysight’s E6961A-FDB Frequency Divider Board
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Static-safe Handling Procedures

Electrostatic discharge (ESD) can 
damage or destroy electronic 
components. Use a static-safe work 
station to perform at work on 
electronic assemblies. This figure 
shows a static-safe work station using 
two types of ESD protection:

– Conductive table-mat and 
wrist-strap combination

– Conductive floor-mat and 
heel-strap combination

Both types, when used together, 
provide a significant level of ESD 
protection. Of the two, only the table-mat and wrist-strap combination provides 
adequate ESD protection when used alone. To ensure user safety, the static-safe 
accessories must provide at least 1 MΩ of isolation from ground.

Observe appropriate ESD precautions before connecting and disconnecting 
cables and changing the positions of jumpers ans switches.

To use the divider board, check the Use 10MHz Ref Clock on the BroadR-Reach 
Compliance Test Application Main Window.
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Figure D-2 Check the Use 10MHz Ref Clock on Main Application Window

Configure the test setup as shown below.
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Figure D-3 Test Setup for 10 MHz Frequency Reference

Frequency Divider Board Test Setup

1 Connect CH1 SMA connector to the Device Under Test (DUT).

2 Use BNC to BNC cables to connect both J400 and J403 BNC connectors to 
the oscilloscope and the AWG 10 MHz In.

3 Select 4.2 Vpp output voltage by shorting Pin1 and Pin2 of J100 with jumper.

4 Select Normal Running mode by switching switch A1 to OFF.

5 Select Frequency Tracking mode by switching switch A2 to OFF.

6 Select CH1 as input by switching switch A6 to OFF.

7 Select Targeted 25 MHz input by switching switch B2 to ON.
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8 Power on the board by connecting a power source to the USB connector or to 
the DC power jack. (4.5V to 5.5V @450mA).

At power on, the:

– Power LED PWR (D303) should light up as GREEN

– LED A (D302) should light up as GREEN

– LED B (D304) should light up as GREEN

Connector Description 

This section describes the various user components on the E6960-26600. 

USB type-B / DC Jack 

Provides power to the fixture. Either the USB port or the 2.5 mm, center positive 
DC Power input jack may be used. The USB jack is not used for any other purpose. 
Input voltage is required to be within +4.5V to +5.5V @500mA. Any voltage that is 
out of specification will trigger a warning on the Power LED. 

SMA 

Provides an interface to feed the input signal into the test fixture. CH1 connector 
is 50 Ω terminated and CH2 connector is 10k Ω terminated. 

BNC 

Both J400 and J403 produce a separate output clock signal. The signals are 
back-terminated by 50 Ω. 

Jumpers 

Provides user the option to modify the test fixture circuitry. 

J100 

This jumper controls the output signal amplitude: 

4.2Vpp: Connect pin 1 and pin 2 

3.3Vpp: Connect pin 2 and pin 3 

3.0Vpp: Connect pin 3 and pin 4 
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J300 & J302 

This jumper allows user to probe the channel 1 and channel 2 inputs respectively 

J401 

This jumper shorts both outputs together. 

J402 

Parking location for unused jumpers. 

DIP Switch Description 

Switch A 

Switch A sets the Fixture operating mode.

Table D-1 Switch Operating Modes

Switches Position Operating mode Comment 

A1 
off Normal running mode Normal operating mode 

on Sleep mode Change made to any of the switches are ignored 

A2 
off Frequency Tracking Mode Output frequency track to input frequency 

on Lock Frequency Mode Output clock is phase lock to input clock 

A3 
off NA NA 

on NA NA 

A4 
off NA NA 

on NA NA 

A5 
off NA NA 

on NA NA 

A6 
off Select CH1 as input NA 

on Select CH2 as input NA 

A7 
off NA NA 

on NA NA 
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Switch B 

Switch B sets the frequency divider to the relevant setting.

Note: Other combinations are not valid. if no valid switch setting is detected, LED 
will flash indicating invalid switch B configuration. After reset, if no valid position 
is detected, the board uses the “Free Run Mode” which generates an accurate 10 
MHz signal. 

A8 
off NA NA 

on NA NA 

Table D-1 Switch Operating Modes

Switches Position Operating mode Comment 

Table D-2 Switch B Operating Modes

Divider Comment 

B1 B2 B3 B4 B5 B6 B7 B8 To obtain 10 MHz output:

off off off off off off off off Not valid (def) Free Run Mode 

on off off off off off off off Div 1 Targeted 10MHz input clock 

off on off off off off off off Div 5/2 Targeted 25MHz input clock 

off off on off off off off off Div 20/3 Targeted 66.67MHz input clock 

off off off on off off off off Div 25/2 Targeted 125MHz input clock 

off off off off on off off off Div 75 Targeted 750MHz input clock 
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LED Description 

Power LED 

LED A 

LED B 

Table D-3 LED Indicators

Green Red 

Input voltage below 4.5V ON Flash 1 Hz 

Input voltage below3.6V ON Flash 2 Hz 

Input voltage above 5.5V ON ON 

Table D-4 LED A Indicators

Green Red 

Input signal locked (Normal condition) ON OFF 

Lost of Lock Flash 1 Hz OFF 

Lost of Signal OFF Flash 1 Hz 

Lost of 48MHz reference OFF ON 

Table D-5 LED B Indicators

Green Red 

Valid switch B configuration (Normal condition) ON OFF 

Invalid switch B configuration Flash 1 Hz OFF 

Missing input signal/ input signal out of range/ Warning. See LED A for list of 
warning 

N/A ON 
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